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Train Induced 
Vibration of a 
Bridge 
For LUSAS version: 21.1 
For software product(s):  Any Plus version 
With product option(s): IMDPlus 
Note: The example exceeds the limits of the LUSAS Teaching and Training Version. 

Description 
This example examines the 
response of a steel rail bridge to 
the passage of a train. 

Units used are N, m, kg, s, C 
throughout. 

 

 

 

Objectives 
The output requirements of the analysis are: 

 Deflections in the X-, Y- and Z-directions for a train speed of 15 m/s 
 Accelerations in the vertical direction for a train speed of 70 m/s 
 Peak deflections and accelerations in the vertical direction for a speed range of 

15 m/s to 70 m/s in 5 m/s intervals 
 Stress resultants and peak stress resultants in main girder web. 
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 Averaged and peak vertical displacements and resultant dynamic amplification 
factors from all of the nodes of the bridge structure 

 Total summed reactions and peak reactions from all of the supported nodes of 
the bridge structure 

 Averaged and peak stresses for a side panel of the bridge structure 
  
Keywords 
3D, Moving Load, Time Domain, Response, Interactive, Modal, Dynamics, IMD,  
IMDPlus, Eigenvalue. 
  
Associated Files 
Associated files can be downloaded from the user area of the LUSAS website. 

 IMDPlus_rail_bridge.lvb Creates a model of the structure. 
 
 ec1-3 Type3.lmd This is an atribute library that contains the Eurocode 

ENV 1991-3 Type 3 moving load train definition for the example. 
 ec1-3 Type3.xls A Microsoft Excel spreadsheet that contains the axle 

positions and loads of the Eurocode ENV 1991-3 Type 3 train set. 
 

Modelling 

Running LUSAS Modeller 
For details of how to run LUSAS Modeller, see the heading Running LUSAS 
Modeller in the Examples Manual Introduction. 

Creating a Model 
• Enter a file name of IMDPlus_rail_bridge.mdl 

• Use the default User-defined working folder. 

• Ensure an Analysis type of 3D is set. 

• Click the OK button. 

Note. There is no need to enter any other new model details when the intention is to 
run a script to build an initial model, since the contents of the script will overwrite any 
other settings made. 

•  To create the model, open the read-only file IMDPlus_rail_bridge.lvb that 
was downloaded and placed in a folder of your choosing. 

 

File 
New… 

 
File 

Script > 
Run Script… 
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Once opened, after a short while the following view of the model of the bridge will be 
displayed. 

 

• Create a new project folder called IMDPlus_rail_bridge and save the model into 
this new folder. This helps keep all relevant IMDPlus created files separate from 
other analyses and is good practice.  

• Turn off the display of the Attributes layer in the  Treeview. 

 

File 
Save As… 
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Note.  No static structural loading is required for this analysis because only the 
dynamic loading is considered during the results processing, which is defined later.  

Modelling Discussion 
The bridge is approximately 16.5m long and 4.75m wide and carries a single track with 
ballast and concrete sleepers. The primary structure is constructed from steel and is 
modelled using shell elements. For this analysis, modelling of the ballast/track-bridge 
interaction has been carried out using a full 3D solid representation of the ballast with 
the sleepers modelled with thick beam elements laid along the top of the ballast. The 
rails of the track have been modelled using thick beam elements spanning between the 
sleepers and the whole ballast/track model is connected to the bridge deck using a 
sliding-only slideline. For the purposes of this example the bridge and ballast model 
has been represented with a coarse mesh and therefore the results from this analysis 
will be less accurate than the use of a finer mesh. For analysing actual structures it is 
recommended that a finer mesh be used which can capture both the vibration modes of 
the bridge and the movement of the load across the bridge more accurately. 

 

Bridge representation 

 
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Ballast representation 

To allow the loading of the rails to be distributed to the 3D solid elements using 
discrete point loads the track modelling uses weak, weightless shell elements which 
span between the beam elements representing the rails. The track representation is 
shown in the following figure.  

 

Track (sleepers and rails) representation 



Train Induced Vibration of a Bridge 

 6 

Note that the line down the centre of the track (Line 12000) is used to define the path of 
the train across the bridge and will be used later in this example. In order to avoid any 
adverse dynamic behaviour of the weak weightless shell elements, only one division is 
used to span between the two rails thus providing full support to the shells without 
adding stiffness to the model. 

Defining Eigenvalue Controls 
Eigenvalue controls are defined as properties of the loadcase. 

• In the  Treeview expand Analysis 1 then right-click on Loadcase 1 and select 
Eigenvalue from the Controls menu.  

The Eigenvalue dialog will appear. 

The following parameters need to be specified: 

• Set the Eigenvalues required to Range 

• Ensure the Range is set to Frequency 

• Set the Minimum frequency as 0 

• Set the Maximum frequency as 35 

• Set the Number of eigenvalues to 0 (this solves for ALL frequencies in the range) 

• Ensure the Type of eigensolver is set as Default 

Note.  Eigenvalue normalisation is set to Mass by default. This is essential if the 
eigenvectors are to be used for subsequent IMD analysis. 

• Click the OK button to finish. 

 Save the model file. 

Running the Analysis 
• With the model loaded click the Solve button  and the Solve Now dialog will 

be displayed. 

• Click the OK button to run the analysis. 

A LUSAS Datafile will be created from the model information. The LUSAS Solver 
uses this datafile to perform the analysis. 

 

File 
Save 
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Viewing the Results 
If the analysis was run from within LUSAS Modeller the results will be loaded on top 
of the current model and the loadcase results for each eigenvalue can be seen in the 
Loadcase layer. Eigenvalue 1 is set to be active by default. 

Checking the Mass Participation Factor 
Note.  In order to carry out a successful IMDPlus analysis you should ensure that a 
significant proportion of the total mass has been accounted for in the analysis. This 
requires checking that around 90% of the total mass has been achieved in the global 
directions. If less than 90% has been achieved no further modes need be included, if 
and only if, the modes of vibration omitted cannot be excited by the dynamic input or a 
significant proportion of the structure is restrained by support in these directions and 
therefore cannot participate in the modes of vibration. The acceptability of the included 
modes of vibration will vary from analysis to analysis but failure to check that a 
significant proportion of the total mass has been accounted for may lead to important 
modes being missed and subsequent errors in the analysis results.   

• Select results type Eigenvalues. For loadcase 1, in the available results panel select 
Sum mass participation factors and click OK. The results will be displayed, and a 
Print Results Wizard entry will be added to the Utilities  treeview. 

 

By inspection it can be seen that the 90% value has almost been achieved in all 
directions for this analysis. This is discussed in the note below. 

 

Utilities 
Print Results 
Wizard… 
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Note.  In this analysis we are only including modes of vibration with frequencies up 
to and including 35 Hz with frequencies higher than this value considered insignificant 
for the analysis. In this analysis (and for mode 19) the results show that 94% of the 
total mass is achieved in the X-direction, 94% is achieved in the Y-direction and 88% 
is achieved in the Z-direction. 

• Close the results window. 

• Select results type Eigenvalues. For loadcase 1, in the available results panel de-
select Sum mass participation factors, then select Mass participation factors 
and click OK.  

The results will be displayed, and a Print Results Wizard entry will be added to the 
Utilities  treeview 

 

From these mass participation factors the major modes of vibration of the bridge can be 
seen to be mode 1 in the Z-direction (vertical), mode 5 in the Y-direction (lateral) and 
mode 11 in the X-direction (longitudinal). 

• Close the results window. 

Plotting Mode Shapes 
• Turn off the display of the Mesh, and Geometry layers in the  Treeview. 

 

Utilities 
Print Results 
Wizard… 
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• With no features selected click the right-hand mouse button in a blank part of the 
View area and select the Deformed mesh option to add the deformed mesh layer to 
the  Treeview. Click the OK button to accept the default values and display the 
deformed mesh for Eigenvalue 1. 

• If supports are shown click on the Supports on/off  button to remove the 
supports from the display. 

• In the panel at the bottom of the  Treeview select the Window summary option 
and click the Details... button. In the Window summary properties dialog set the 
position to (15.0,-15.0) and click the OK button to return to the view window. 

This mode of vibration is the primary mode in the vertical direction as determined in 
the section titled ‘Checking the Mass Participation Factor’.  

 

By setting each Eigenvalue to be active the deformed mesh can be seen for all mode 
shapes.  

Note.  The mode shapes may be inverted. This is because the sense is arbitrary since 
during vibration the deformed shape will appear in both directions. 

• In the  Treeview right-click on Mode 5 Frequency = 16.2725 and select the Set 
Active option. The deformed mesh plot for this eigenmode will be displayed.  

This mode of vibration has the highest participating mass in the lateral (Y) direction for 
the whole bridge as determined in the ‘Checking the Mass Participation Factor’ section. 

 
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Note.  The window summary displays the values of the eigenvalue and the natural 
frequency and also a value for displacement at a node. It should be noted that the 
displacement value is non-quantitative and is related to the amount of mass in a 
particular mode using the mass normalisation technique. Therefore the only items that 
can be found using a basic eigenvalue analysis are the frequency and the mode shape. 

Selecting individual nodes and elements of interest 
Prior to running an IMDPlus analysis, individual node and element numbers for the 
locations of the structure that will be assessed should be ascertained. This can be done 
by selecting the locations of interest with the cursor and noting down the numbers of 
the node and elements concerned. 

• Turn off the display of the Deformed mesh and Annotation layers in the  
Treeview. 

• In the  Treeview double-click on the Mesh layer name and click the OK button 
to accept the default settings. This will turn on the layer. 

To view just the bridge structure without the ballast and track: 

• In the  Treeview click the right-hand mouse button on the group name 
Bridge_Structure and select the Set as Only Visible option from the drop-down 
menu. 

By selecting or moving the cursor over the node and element shown, the node or 
element number of interest can be obtained. For the first stage of this analysis we are 
interested in the node at the centre of the bridge deck (node 1696) and the element in 
the middle of the side girder (element 1209), as shown in the following figures. 

 
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Defining the Eurocode ENV 1991-3 Type 3 Trainset 
Before the analysis can be performed, we need to define the moving load representation 
of the Eurocode ENV 1991-3 Type 3 trainset in LUSAS Modeller. 

Note.  To simplify the use of IMDPlus (and provide an alternative to picking 
IMDPlus menu selections from the Analyses > IMDPlus menu items) for the rest of the 
example it is recommended that the IMDPlus toolbar is enabled in LUSAS Modeller.  

• Select the View > Toolbars... menu item, select the Toolbars tab, enable the 
IMDPlus option in the list and click Close. 

• If the IMDPlus toolbar has been enabled, click on the  Moving Load analysis 
button in the toolbar to select a moving load analysis and enable the tool button 
shortcuts to the dialogs. 

 This displays the Moving Load Vehicle Configuration dialog. 

The moving load vehicle is to be defined using the positions of the axles relative to the 
front of train together with the moving load factors to be applied at each position. To 
simplify the definition of the vehicle the positions and loads are included in a Microsoft 
Excel spreadsheet so they can be copied and pasted into the dialog. 

• Locate the spreadsheet named ec1-3 
Type3.xls in the downloaded 
\Lusas_associated_examples_files 
folder and open it. 

• Select all of the 60 positions and 
loads in the first and second columns 
and copy these to the clipboard using 
the Ctrl+C keys. 

• In the Modeller dialog, select both 
the Position and Load headers of the 
grid in the dialog and paste the 
copied data into the grid using the 
Ctrl+V keys. 

• Enter the name as ec1-3 Type3 

Once finished the dialog should appear as shown. 

• Click OK to create the vehicle configuration. 

Note.  The positions of the axles are defined as negative values to ensure that the 
whole trainset passes over the structure. Negative values place the axles behind the 

 

Analyses 
IMDPlus  >  

Moving Load >  
Vehicle 
Configuration... 

 

 
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front of the train which is at a position of 0. The movement of the front of the train will 
be calculated from the start of the path to the end of the path with additional time 
included in the IMDPlus solution to allow all of the axles with negative positions to 
pass along the path. 

If any axles are defined with positive values, then these will already be the distance 
down the path equivalent to the position entered in the vehicle configuration. Those 
axles with positive positions may already be over the structure at the start of the 
IMDPlus analysis if the start of the path has not been defined to account for this. If any 
positive positions are used, then always ensure that the lines defining the beginning of 
the path allow sufficient additional length in order to model the transition of the whole 
of the train onto the structure correctly. 

Note.  Once a trainset or vehicle has been defined it can be saved in a library so it can 
be imported and used in future analyses without the need to go through all of the 
definition process above. This is achieved through the Library Browser accessed 
through the File > Import/Export Model Data... menu command. 

Importing a Vehicle  
If it proves time consuming or you are unable to obtain the same results shown later in 
the example the vehicle definition can be imported from the library provided in the 
\Lusas_associated_examples_files folder. 

 The ec1-3 Type3.lmd  contains the vehicle library for the example.  
 
 

• Select the Import from library to model option. 

Click on the Choose file... button and browse to the ec1-3 Type3.lmd file in the 
\Lusas_associated_examples_files folder. 

• Select the IMDPlus (1) entries in the tree. 

• Click the OK button. 

 

After vehicle configuration attribute has been 
defined it will appear in the  Utilities 
treeview 

Note. If it is required to edit the vehicle 
configuration attribute simply double-click with 
the left mouse button or right-click and choose 
Edit Attribute... on the name of the attribute to 

 

  
File 

Import/Export Model 
Data… 

 

 
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bring up the original dialog. 

Moving Load Analysis 
Moving load calculations are performed using the IMDPlus (Interactive Modal 
Dynamics) facility. In order to carry out the moving load analysis of the train travelling 
across the bridge we need to carry out three stages: 

1. Define and set-up the path along which the moving loads will travel using a unit 
load defined as either a discrete point or patch load. For this example the unit 
axle load has already been defined as a discrete point load called Unit Axle 
Load which acts vertically 

2. Convert the loading along this path from this unit load into modal forces that are 
applied in the IMDPlus moving load analysis. 

3. Run an IMDPlus moving load analysis to calculate the response of the bridge. 

Note.  This process is similar to the IMDPlus moving mass analysis procedure but 
with the trainset / vehicle defined by constant forces rather than spring-mass systems. 

Note.  Before an IMDPlus analysis can be carried out the load that is going to pass 
over the structure must be defined using either discrete point or patch loads. For this 
example this has already been carried out with a single axle of unit load defined as a 
discrete point load. Defining a single axle allows multiple load configurations to be 
analysed through the composite axle definition method in IMDPlus without the need to 
carry out the path and modal force stages for each layout. For railways the axle lengths 
remain constant over all of the train set and this method would normally be used. For 
moving loads where axles are of different widths the full definition of the load must be 
carried out with the path and modal force stages carried out for each layout. 

Defining the Moving Load Path 
To solve for the passage of the train across the bridge the path for the moving load 
must be defined. Line 12000 (the line representing the path of the moving load) will be 
set to be the current selection. 

To view the complete model again: 

• In the  Treeview click the right-hand mouse button on the group name IMDPlus 
Rail Bridge.mdl and select the Visible option from the drop-down menu. Click 
Yes when asked whether to act on subgroups as well. 

• In the  Treeview double-click on the Geometry layer name and click the OK 
button to accept the default settings. This will also turn on the layer. 

• Select the line shown (line 12000) 

 
 
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Note.  The path can be built from multiple lines and arcs but these must form a 
continuous path without branching. 

 

 This opens the IMDPlus Moving Load Generation dialog. 

On startup of the IMDPlus Moving Load Generation dialog, all valid discrete loads and 
search areas will be made available in the loading options along with information about 
the path defined by the current selection.  

In this example a single discrete load called Unit Axle Load which defines the unit 
loading from a single axle of the train is present along with a search area that is 
assigned to the weak weightless shells. 

 

Analyses 
IMDPlus  >  

Moving Load >  
Moving Load 
Generation... 
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• Ensure 1:Unit Axle Load is selected 
from the Moving load dataset list. 

• Ensure 1:Track_Search_Area is 
selected from the Search area ID for 
the assignment of the discrete 
loading. 

• Ensure Project over area is selected. 

• Click on the Advanced button to 
adjust the inclusion of load 
characteristics. On the Moving Load 
Advanced Options dialog choose the 
Include full load option for loads 
outside the search area and click the 
OK button. 

• On the IMDPlus Moving Load 
Generation dialog set the 
Incremental distance to 0.1 

Note.  Using search areas targets the application of the loading to the required 
features as described in the Modeller Reference Manual. 

Note.  By default the incremental distance is set to one tenth of the length of the line 
along which the load moves. 

• Click the OK button to proceed and choose Yes to accept the warnings and save the 
current model. 

The program will now generate the loading information for the 274 locations of the unit 
axle along the path before returning control back to LUSAS Modeller. This process 
does not need to be repeated unless the lateral configuration of the load changes. For a 
railway this will not happen, but it may be required for highway analyses where the 
axle lengths and tyre configurations could vary. 

Note.  The discrete loading locations defined by this dialog will be tabulated into 
three datafiles with a maximum of 100 loadcases each and the analyses will be 
performed automatically. These analyses will use the same file basename as the 
original model with a numeric indicator appended to it (e.g. _00001, _00002, etc). They 
are required for the modal force calculation stage. 

 

 
 

 
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Generating the Modal Force History for the Moving Load 
In the previous stage the passage of the train axle across the structure has been defined. 
The modal forces for the IMDPlus solution now need to be calculated using the Modal 
Force Calculator. 

 This opens the IMDPlus Modal Force Calculator dialog.  

• Click the OK button to accept 
the default information and 
proceed. 

Note.  This process does not 
need to be repeated unless the 
moving load path or configuration 
in Stage 1 is changed. 

 

 

 

Defining the Moving Load Parameters 
All of the basic moving load information has now been defined for the IMDPlus 
analysis. The next stage is to define the included modes, damping and speed 
parameters. 

 This opens the IMDPlus Moving Load Analysis Control dialog. 

Analyses 
IMDPlus  >  

Moving Load >  
Modal Force 
Calculator... 

 

 

Analyses 
IMDPlus  >  

Moving Load >  
Moving Load 
Analysis... 
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• Click on the Vehicle 
Configuration 
(Composite axle) 
option since we are 
using a unit load axle 
definition. 

• Ensure the Vehicle 
configuration contains 
1:ec1-3 Type3 

• Ensure that Included 
modes is set to All. If 
this is not the case, 
click on the Modify… 
button and ensure the 
All modes option is 
selected. 

• Ensure Default 
damping of 5.0 is 
selected. If a different 
damping is displayed, click on the Modify… button and set the Default damping 
to 5.0 

• In the Solution control section, click on the Modify... button to change the 
advanced solution options. Click the Defaults button to set the default options and 
click the OK button. 

• Enter the Minimum Speed as 15, the Maximum Speed as 70 and the Speed 
Increment as 5 

• Deselect the IMDPlus determining time step (Nyquist) option so we can specify 
the required time step 

• Enter the Solution time step as 1E-3 

• Click the Next button to proceed. When prompted about significant missing total 
mass choose Yes to continue. For this analysis we are only interested in the 
contributions of modes of vibration up to and including 35Hz which means that we 
are not going to achieve the 90% total mass target. 

The information entered above will analyse the passage of a Eurocode ENV 1991-3 
Type 3 train (with axle details as held in the file ec1-3 Type3.xls) across the bridge for 
a speed range of 15 m/s to 70 m/s in increments of 5 m/s (or 54 kph to 252 kph in 
increments of 18 kph). The quiet time allows for the decay of the response of the bridge 
after the train has passed across and the solution time step forces the time step to be 
used in the analyses. 
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Displaying Individual Node and Element Results for 
Moving Load Analysis 
The IMDPlus Output Control dialog will appear. This controls the results output for the 
model. 

Displacement and Acceleration Graphs 
The response of the mid-span of the bridge for the range of speeds selected will be 
investigated. Initially we will look at the displacements of the mid-span for a single 
speed of 15 m/s (or 54 kph). 

Enter the following information into the output control dialog: 

• Choose Node and 
select Extent as 
Individual 

• Enter Node number 
1696 (This is the node 
in the centre of the 
bridge deck at the mid-
span of the bridge) 

• Select Displacement 
results of DX, DY & 
DZ 

• Ensure Individual 
items is selected. Sum 
of chosen items and 
Average of chosen 
items will not be 
available as an 
individual node is 
being processed. 

• Ensure Response time history is selected. 

• Ensure Generate graphs in Modeller is selected. 

• Ensure Speed to graph is set to be 1:15.0 which indicates that the first speed of 15 
m/s is being processed. 

• Click the Apply and not the Finish button to proceed.  

Note.  Clicking the Apply button instead of the Finish button keeps the IMDPlus 
Control Dialog accessible for subsequent graph plotting. 

 

 
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The IMDPlus analysis will now run. 

 

• After the graph has been displayed and viewed, close the graph 

The vertical acceleration response of the mid-span for a single speed of 15 m/s (or 54 
kph) will now be investigated.  

If the IMDPlus toolbar has been enabled, 

• Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

• Open the IMDPlus Moving Load Analysis Control dialog and click Next > to keep 
the existing analysis control settings and open the IMDPlus Output Control dialog. 

 

Analyses 
IMDPlus  >  

Moving Load >  
Moving Load 
Analysis... 
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• On the IMD Output 
Control dialog select 
Acceleration results of 
AZ for the vertical 
component only 

• Click the Apply button 
and not the Finish 
button to proceed.   

Note.  IMDPlus does not 
need to be rerun since the 
acceleration results were 
computed at the same time 
as the displacement results. 

 

 

 

 

 

• When the graph has been displayed, close the graph 

Previously we have investigated the displacement and acceleration response of the mid-
span of the bridge deck for a single train speed. We will now look at the peak positive 
and negative vertical displacement and acceleration responses of the mid-span over the 
speed range of 15 m/s to 70 m/s as specified previously in the moving load analysis 
control dialog. 

If the IMDPlus toolbar has been enabled, 

 

 
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• Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

• Open the IMDPlus Moving Load Analysis Control dialog and click Next > to keep 
the existing analysis control settings and open the IMDPlus Output Control dialog. 

 

• On the IMDPlus 
Output Control dialog 
select Displacement 
results of DZ for the 
vertical component 
only. 

• Deselect the Response 
time history option. 

• Select the Peak 
response summary 
option. 

• Select 
Positive/negative 

• Click the Apply button 
to proceed. 

The IMDPlus analysis will 
now run.  

 

Analyses 
IMDPlus  >  

Moving Load >  
Moving Load 
Analysis... 
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• When the graph has been displayed, close the graph. 

 If the IMDPlus toolbar has been enabled, 

• Click on the  button in the toolbar to open the IMDPlus Output Control dialog. 

If the IMDPlus toolbar is not enabled: 

• Open the IMDPlus Moving Load Analysis Control dialog and click Next > to keep 
the existing analysis control settings and open the IMDPlus Output Control dialog. 

 

• Select Acceleration results of AZ for the vertical component only 

• Click the Apply button to display a graph of acceleration versus speed at the mid-
span. 

 

• When the graph has been displayed, close the graph 

Stress Resultant Graphs for Shells 
In the previous section the displacement and acceleration responses at the mid-span of 
the bridge were investigated. We will now look at the stress resultants in the web of 
one of the main girders. Results for element number 1209 in the centre of the web of 
the nearside girder (as previously determined) will be investigated. 

If the IMDPlus toolbar has been enabled, 

• Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled: 

Analyses 
IMDPlus  >  

Moving Load >  
Moving Load 
Analysis... 
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• Open the IMDPlus Moving Load Analysis Control dialog and click Next > to keep 
the existing analysis control settings and open the IMDPlus Output Control dialog. 

 

Enter the following information into the IMDPlus Output Control dialog. 

• Select Element and 
ensure Extent remains 
set as Individual 

• Enter Element number 
1209 

• Set Gauss Point to 1 

• Select Force/Moment 
– Thick Shell results 
of Nx which is the 
stress resultant in the 
longitudinal bridge 
direction. 

• Ensure Individual 
items is selected. ‘Sum 
of chosen items’ and 
‘Average of chosen 
items’ will not be 
available as an 
individual element is being processed. 

• Ensure the Response time history option is selected. 

• Deselect the Peak response summary option. 

• Set the Speed to graph as 12:70.0 which indicates that the twelfth listed speed of 
70 m/s is being processed. 

• Click the Apply button to display a graph of Nx versus time for gauss point 1 of 
element 1209.  

The IMDPlus analysis will now run and a graph of Nx versus time for gauss point 1 of 
element 1209 will be displayed. 

Analyses 
IMDPlus  >  

Moving Load >  
Moving Load 
Analysis... 
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• When the graph has been displayed, close the graph 

If the IMDPlus toolbar has been enabled, 

• Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

• Open the IMDPlus Moving Load Analysis Control dialog and click Next > to keep 
the existing analysis control settings and open the IMDPlus Output Control dialog. 

 

• Select Force/Moment – Thick Shell results of Mx which is the moment in the 
along bridge direction. 

• Leaving all previous options set as they were, click the Apply button to proceed. 

After a short pause a graph of Mx versus time for gauss point 1 of element 1209 will be 
created. 

Analyses 
IMDPlus  >  

Moving Load >  
Moving Load 
Analysis... 
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• When the graph has been displayed, close the graph 

If the IMDPlus toolbar has been enabled, 

• Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

• Open the IMDPlus Moving Load Analysis Control dialog and click Next > to keep 
the existing analysis control settings and open the IMDPlus Output Control dialog. 

 

• Deselect the Response time history option. 

• Select the Peak response summary option and select Absolute 

• Click the Finish button. 

• Click Yes when asked whether to free up disk space by deleting the temporary files 
created by IMDPlus. 

A graph of absolute peak Mx versus speed for gauss point 1 of element 1209 will be 
generated. 

Analyses 
IMDPlus  >  

Moving Load >  
Moving Load 
Analysis... 
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• Close the graph window. 

Displaying Results for a Selection of Nodes and Elements 
In the preceding sections the analyses utilised individual nodes and elements of the 
structure. In the following sections chosen sets of nodes and elements will be used in 
order to investigate the following results for the bridge structure: 

 Averaged and peak displacements and dynamic amplification factors 
 Total summed reactions and peak reactions 
 Averaged and peak stresses in a side panel 

Averaged and Peak Displacements and Dynamic 
Amplification Factors for the Bridge Structure 
In order to examine the averaged and peak displacements and dynamic amplification 
factors, a selection of nodes needs to be created that contains all of the nodes of the 
bridge structure.  

• Turn off the Geometry layer in the Treeview. 

• In the  Treeview click the right-hand mouse button on the group name 
Bridge_Structure and select the Set as Only Visible option from the drop-down 
menu. 

 Using Select Nodes drag a box around the model to select all of the 1665 nodes of 
the bridge structure, as shown in the following figure. 
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• Open the IMDPlus Moving Load Analysis Control dialog through the menu or click 

on the  button in the toolbar. 

• On the IMDPlus Moving Load Analysis Control dialog click the Next button to 
accept the previously defined values. When prompted about the total mass 
participation click the Yes button to continue. 

Enter the following information into the IMDPlus Output Control dialog. 

Analyses 
IMDPlus  >  

Moving Load >  
Moving Load 
Analysis... 
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• Select Node and 
change Extent to 
Selected using the 
drop-down list. This 
chooses all 1665 nodes 
of the bridge structure 
that were selected in 
the preceding step. 

• Select result entity 
Displacement and 
component DZ 

• Deselect Individual 
items 

• Select Average of 
chosen items as only 
the averaged results for 
the selected nodes are 
going to be 
investigated. 

• Ensure Peak response summary remains selected, then select Positive/negative 
and Envelope 

• Ensure Generate graphs in Modeller remains selected. 

• Click the Apply button to perform the analysis. Click Yes when asked whether you 
want to process all of the selected nodes. 

The IMDPlus analysis will now run. On modern computers this will take under 15 
minutes.  

Note.  Any combination of the options Individual items, Sum of chosen items and 
Average of chosen items output can be used together in an IMDPlus analysis, 
although using the Individual items option when Extent is set to Selected or All 
(nodes or elements) may produce a large number of graphs, depending on the number 
of nodes or elements chosen for processing. 

Note.  Average of chosen items obtains results by first summing the results from the 
selected nodes. A simple average of this summed result is obtained to give the averaged 
node time histories from which the peak average results are obtained. 

A graph of peak positive and negative results for the averaged vertical (DZ) 
displacements, for all of the speeds analysed, 15m/s to 70m/s, is displayed as shown in 
the following figure. From the adjacent tabbed data table, it can be seen that the largest 

 

 

 
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peaks occur at a speed of 55m/s, with positive and negative peak values of 0.0013m 
and -0.006m respectively. 

 

An envelope of the peak displacements and rotations for the selected nodes is displayed 
on screen in Notepad and written to the file peak_dspSet1.sum which can be found in 
the \LUSASFiles32\IMDPlus_rail_bridge\IMDPlus_Graphing folder.  

By investigating all of the speeds analysed it can be seen that the individual peak 
vertical (DZ) displacements also occur at a moving load speed of 55m/s.  

 

Both positive and negative peak Z-displacements occur at node 1648 with respective 
values of 0.0044m at time 4.656 seconds and -0.0203m at time 6.826 seconds. 

Note.  The envelope of the peak results is obtained in IMDPlus by examining the 
individual results from all of the nodes in the bridge structure. This enables the 
locations of the nodes with maximum and minimum results to be quickly identified. 

• Close the Notepad application and graph windows. 

 
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If the IMDPlus toolbar has been enabled, 

• Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

• Open the IMDPlus Moving Load Analysis Control dialog and click Next > to keep 
the existing analysis control settings and open the IMDPlus Output Control dialog. 

 

Enter the following information 
into the IMDPlus Output Control 
dialog. 

• Ensure Node and extent 
Selected are chosen. 

• Select result entity Dynamic 
Amplification Factor and 
component DAF_RSLT 

• Ensure Average of chosen 
items is selected. 

• Ensure Peak response 
summary and Envelope 
remain selected and select 
Absolute 

• Click the Finish button. Click 
Yes when asked whether you want to process all of the selected nodes. 

• Click Yes when asked whether to free up disk space by deleting the temporary files 
created by IMDPlus. 

A graph showing the absolute peak of the average resultant dynamic amplification 
factor against speed is displayed, as shown in the following figure. From the adjacent 
tabbed data table, this shows that a maximum averaged DAF of 1.217 occurs at speed 
55m/s. 

Note.  Only averaged dynamic amplification factor results can be obtained for a set of 
nodes as summed results are meaningless for this result entity. 

Analyses 
IMDPlus  >  

Moving Load >  
Moving Load 
Analysis... 

 

 
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An envelope of the peak dynamic amplification factors for the selected nodes is 
displayed on screen in Notepad and written to the Abs_peak_dafSet1.sum which can 
be found in the \LUSASFiles32\IMDPlus_rail_bridge\IMDPlus_Graphing folder.  

 

These results indicate that the individual peak resultant DAF occurs at a speed of 
60m/s. A value of 1.76 is calculated at a solution time of 0.53 seconds at node 41. 

• Close the Notepad application and graph window. 

Total and Peak Reactions for the Bridge Structure 
The total sum of the reactions and the peak reactions that act on the bridge structure for 
each of the moving load speeds will now be investigated. The set of nodes from the 
preceding section could be utilised for this purpose. However, in order to improve the 
efficiency of the IMDPlus solution, the chosen selection of nodes will be reduced so 
that it only includes the geometric features that contain the supported nodes of the 
bridge structure. 

• Click the left-hand mouse button in a blank part of the view window to remove the 
node selection created in the preceding section. 
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 In the LUSAS view window click on the Supports on/off button to show the 
supported nodes in the model. 

• In the  Treeview click the right-hand mouse button on the group name 
Bridge_Structure and select the Set as Only Visible option from the drop-down 
menu. 

• Turn on the Geometry layer in the Treeview. 

 Using the Select Volumes cursor drag a box around the entire bridge structure to 
select the volumes immediately above the bridge supports, as shown in the following 
figure. 

 

• Click the right-hand mouse button in a blank part of the view window and select the 
Keep as Only Visible option. Only the selected volumes will remain visible. 

  Using the Select Nodes cursor drag a box to select the 120 visible nodes of the 
bridge structure, as shown in the following figure. 
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 Open the IMDPlus Moving Load Analysis Control dialog. 

• Click the Next button to accept the previously defined values. When prompted 
about the total mass participation click the Yes button to continue. 

• Enter the following information into the IMDPlus Output Control dialog. 

Analyses 
IMDPlus  >  

Moving Load >  
Moving Load 
Analysis... 
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• Select Node and ensure 
Extent remains set to 
Selected. This chooses 
the 120 visible nodes 
of the bridge structure 
that were selected in 
the preceding step. 

• Select result entity 
Reaction and 
component FZ 

• Deselect Average of 
chosen items  

• Select Sum of chosen 
items. Ensure 
Individual items 
remains deselected. 

• Select Response time 
history 

• Ensure Peak response summary and Envelope remains selected and select 
Positive/negative 

• Ensure Generate graphs in Modeller remains selected. 

• Set the Speed to graph as 9:55.0 which indicates that the ninth listed speed of 55 
m/s is being processed. 

• Click the Finish button to perform the analysis of the node set. Click Yes when 
asked whether you want to process all of the selected nodes. 

• Click Yes when asked whether to free up disk space by deleting the temporary files 
created by IMDPlus. 

Note.  Sum of chosen items adds together the results from the selected nodes to give 
the summed nodal time histories from which the peaks of the summed results are 
obtained.  

Note.  Average of chosen items obtains results by first summing the results from the 
selected nodes. A simple average of this summed result is obtained to give the averaged 
node time histories from which the peak average results are obtained. 

The summed nodal results that give the total vertical reactions acting on the bridge 
structure are displayed. The graph of the peak positive and negative summed reaction 
in the Z-direction for all of the speeds analysed is shown in the following figure.  

 

 

 
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From the adjacent tabbed data table, examining the results for each speed shows a 
positive peak reaction of 986.8kN at a train speed of 55m/s and a negative holding 
down peak reaction of -161.3kN at a speed of 60 m/s. 

 

In addition, accessible form the Window menu item, the following figure shows the 
time history of the summed FZ reactions for the analysis speed of 55m/s. From the 
graph data for this speed it can be seen that the positive peak value of 986.8kN occurs 
at an analysis time of 6.812 seconds. 

 

The envelope of the peak reactions from file peak_rctSet1.sum are displayed in a 
Notepad application. These give a summary of the peak reactions obtained from all of 
the individual nodes of the bridge structure for each of the moving load speeds 
analysed. The vertical (FZ) component of interest shows consistently that the maximum 
positive reaction (from a downward force) occurs at node 82 and the maximum 
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negative reaction (from an upward force) occurs at node 74. Results for speeds of 
55m/s and 60m/s are shown in the following figure.  

 

From the above data, the maximum positive reaction of 215.6kN is seen to occur at a 
time 0.575 seconds for speed 55m/s and the maximum negative reaction of -146.7kN 
occurs at a time 6.368 seconds for speed 60m/s. 

• Close the Notepad application and graph windows. 

The nodes 81 and 9 representing the location of two of the vertical supports for the 
bearings of the bridge will now be selected in the model. 

• Click the left-hand mouse button in a blank part of the view window to remove the 
node selection created in the preceding section. 

• In the  Treeview click the right-hand mouse button on the group name 
Bridge_Structure and select the Set as Only Visible option from the drop-down 
menu. 

• Turn off the Geometry layer in the Treeview. 
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• With no features selected click the right-hand mouse button in a blank part of the 
view window and select the Labels option to add the labels to the Treeview. 

• On the Properties dialog select the Node / Name and Label selected items only 
check boxes. 

• Click the Advanced... button, then click the Font… button and select Arial, Bold, 
12 and click OK.  

• Click the OK button as necessary to accept all other settings. This will turn on the 
layer in the view window. 

• With no features selected click the right-hand mouse button in a blank part of the 
view window and select the Advanced Selection... option. 

• Select Type and Name, select Node from the drop-down list and enter node 
number 81 

• Select Add to selection and click the Apply button to accept all other settings. 
Node 81 will be highlighted in the view window.  

• Enter node number 9 and click the OK button. Node 9 will also be displayed in the 
view window, as shown in the following figure. 

 

The node locations chosen are shown below for clarity. 
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• Click the left-hand mouse button in a blank part of the view window to remove the 
node selection. 

Average and Peak Stresses in a Side Panel of the Bridge 
Structure 
Finally, the average peak and total peak in-plane shear stresses in a side panel of the 
bridge structure will be investigated. 

• Double-click on the Labels layer name in the Treeview. 

• On the Properties dialog deselect the Node / Name check box and select the 
Element / Name check box.  Click the OK button. 

 Using the Select Elements cursor, select the six elements that form the side panel 
of the bridge structure, as shown in the following figure. 
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Note.  Only elements of the same type, for example, thick beam elements, continuum 
elements or thick shell elements can be used in a set of IMDPlus elements. However, 
the element set may contain elements with different numbers of Gauss points or nodes. 

 Open the IMDPlus Moving Load Analysis Control dialog. 

• Click the Next button to accept the previously defined values. When prompted 
about the total mass participation click the Yes button to continue. 

Enter the following information into the IMDPlus Output Control dialog. 

 
Analyses 

IMDPlus  >  
Moving Load >  

Moving Load 
Analysis... 
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• Select Element and set 
Extent to Selected 
from the drop-down 
list. This chooses the 6 
elements of the bridge 
structure that were 
selected in the 
preceding step. 

• Select result entity 
Stress (middle) – 
Thick Shell and 
component Sxy 

• Deselect Sum of 
chosen items and 
select Average of 
chosen items.  

• Ensure Individual 
Items remains 
deselected. 

• Deselect Response time history 

• Ensure Peak response summary, Positive/negative and Envelope all remain 
selected. 

• Ensure Generate graphs in Modeller remains selected. 

Note.  As Extent has been set to Selected the drop-down lists Element and Gauss 
Point are not available for selection. In addition the element Gauss Point is 
automatically set to All as multiple elements are going to be processed in a single 
analysis. 

• Click the Finish button to perform the analysis of the element set. Click Yes when 
asked whether you want to process all of the selected elements. 

• Click Yes when asked whether to free up disk space by deleting the temporary files 
created by IMDPlus. 

The graph shown in the following figure is displayed. It shows the peak positive and 
negative, average middle shear stress, Sxy, for the side panel of the bridge structure.  

 

 
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From the associated graph data table, the largest positive and negative peaks are seen to 
occur at a speed of 55m/s with values of 2.03Mpa and -10.2MPa respectively. 

Note.  The option Average of chosen items obtains the element results by first 
summing the results from all of the Gauss points of the selected thick shell elements. A 
simple average of these summed results is obtained to give the average element 
response time histories from which the peak average results are obtained. 

An envelope of the peak element stresses for each of the moving load speeds is 
displayed in Notepad in file peak_stressSet1.sum. This gives a summary of the peak 
stresses and stress resultants obtained by examining all of the individual Gauss point 
results of the selected elements. The results for speed 55m/s are shown in the following 
figure.  

 
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The maximum positive and negative middle in-plane shear (Sxy) stress occurs at Gauss 
point 2 of element 576. Values of 2.67MPa at time 7.224 seconds and -13.6MPa at time 
6.798 seconds are observed. 

• Close the Notepad application and graph windows. 

Save the model 
• Save the model. 

 

File 
Save… 
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This completes the example. 
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